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EXECUTIVE SUMMARY 

 
 

A usability test of Thrive Version 20 was conducted in May, 2017 in Mobile, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Clinical Decision Support (CDS) in the EHR 

Under Test (EHRUT). During the usability test, 10 healthcare providers matching the target 

demographic criteria served as participants and used the EHRUT in simulated, but 

representative tasks. 

 

This study collected performance data on 9 tasks typically conducted with Clinical Decision 

Support on an EHR: 

1. Configure CDS interventions and reference resources 

2. Trigger CDS interventions using data elements from the problem list and access  

    Diagnostic and therapeutic reference information using the Infobutton.  

3. Trigger CDS interventions using data elements from the medication list and 
access  

                     Diagnostic and therapeutic reference information using the Infobutton 

4. Trigger CDS interventions using data elements from the medication allergy list.  
5. Trigger CDS interventions using data elements from the demographics and 

access  
    Diagnostic and therapeutic reference information using the Infobutton  
6. Trigger CDS interventions using data elements from the lab tests 
7. Trigger CDS interventions using data elements from the vital signs 
8. Receive CDS interventions based on data elements in the problem list and  
    Medication list after incorporating a CCDA 
9. Access the following attributes for a CDS intervention: bibliographic citation,  
    Developer, funding source, release/revision date 
 

 
During the 180 minute one-on-one usability test, each participant was greeted 

by the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 
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The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give 

the participant assistance in how to complete the task. Participant screens, 

head shots and audio were recorded for subsequent analysis. 

 

 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 
• Number and types of errors 

 

• Path deviations 
 

• Participant’s verbalizations 
 

• Participant’s satisfaction ratings of the system 
 
 

All participant data was de-identified – no correspondence could be made from 

the identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in 

accordance with the examples set forth in the NIST Guide to the Processes 

Approach for Improving the Usability of Electronic Health Records, were used to 

evaluate the usability of the EHRUT. Following is a summary of the performance 

and rating data collected on the EHRUT. 

 

170.314(a)(9) Clinical Decision Support  
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Configure 

CDS 

interventions 

and reference 

resources 

10 100% 1:1 45 6 1:1 0% 5 
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2. Trigger CDS 

interventions 

using data 

elements from 

the problem list 

and access 

Diagnostic and 

therapeutic 

reference 

information 

using the 

Infobutton 

10 80% 1.07:1 67.5 53 1.17:1 20% 4.8 

Trigger CDS 

interventions 

using data 

elements from 

the medication 

list and accces 

Diagnostic and 

therapeutic 

reference 

information 

using the 

Infobutton 

10 100% 1:1 67.5 30 1:1 0% 5 

Trigger CDS 

interventions 

using data 

elements from 

the medication 

allergy list. 

10 100% 1:1 45 6 1:1 0% 5 

Trigger CDS 

interventions 

using data 

elements from 

the 

demographics 

and access 

Diagnostic and 

therapeutic 

reference 

information 

using the 

Infobutton 

10 100% 1:1 45 9 1:1 0% 5 

Trigger CDS 

interventions 

using data 

elements from 

the lab tests 

10 100% 1:1 67.5 34 1:1 0% 5 

Trigger CDS 

interventions 

using data 

10 100% 1:1 45 7 1:1 0% 5 
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elements from 

the vital signs 

Receive CDS 

interventions 

based on data 

elements in the 

problem list and  

    Medication 

list after 

incorporating a 

CCDA 

10 100% 1:1 45 7 1:1 0% 5 

Access the 

following 

attributes for a 

CDS 

intervention: 

bibliographic 

citation,  

    Developer, 

funding source, 

release/revision 

date 

10 100 1:1 45 9 1:1 0% 5 

 
 

The results from the System Usability Scale scored the subjective satisfaction 

with the system based on performance with these tasks to be: 77.5.  

 

 

In addition to the performance data, the following qualitative observations were 

made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
 

- Areas for improvement 
 
 

• Users found the font size to be small. 
• Move the different user options to one area of the screen. 

INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 20. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 
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complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of the Clinical Decision Support (CDS) in the EHR Under 

Test (EHRUT). To this end, measures of effectiveness, efficiency and user satisfaction, 

such as time on task and reactions to screens, were captured during the usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 

participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 
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Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 

used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 
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without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

9 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Clinical Decision Support alerts on this 

EHR: 

1. Configure CDS interventions and reference resources 

2. Trigger CDS interventions using data elements from the problem list and access  

    Diagnostic and therapeutic reference information using the Infobutton.  

3. Trigger CDS interventions using data elements from the medication list and 
access  

                     Diagnostic and therapeutic reference information using the Infobutton 

4. Trigger CDS interventions using data elements from the medication allergy list.  
5. Trigger CDS interventions using data elements from the demographics and 

access  
    Diagnostic and therapeutic reference information using the Infobutton  
6. Trigger CDS interventions using data elements from the lab tests 
7. Trigger CDS interventions using data elements from the vital signs 
8. Receive CDS interventions based on data elements in the problem list and  
    Medication list after incorporating a CCDA 
9. Access the following attributes for a CDS intervention: bibliographic citation,  
    Developer, funding source, release/revision date 
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Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Clinical Decision Support alerts in Thrive.  After the session participants had 

the opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
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instructions on use. 
• Without using a think aloud technique. 

 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 
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monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
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the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 

 
 

Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
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DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
Effectiveness: 

 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 
The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 
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Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  

Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.314(a)(9) Clinical Decision Support 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 
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# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Configure 

CDS 

interventions 

and reference 

resources 

10 100% 1:1 45 6 1:1 0% 5 

2. Trigger CDS 

interventions 

using data 

elements from 

the problem list 

and access 

Diagnostic and 

therapeutic 

reference 

information 

using the 

Infobutton 

10 80% 1.07:1 67.5 53 1.17:1 20% 4.8 

Trigger CDS 

interventions 

using data 

elements from 

the medication 

list and accces 

Diagnostic and 

therapeutic 

reference 

information 

using the 

Infobutton 

10 100% 1:1 67.5 30 1:1 0% 5 

Trigger CDS 

interventions 

using data 

elements from 

the medication 

allergy list. 

10 100% 1:1 45 6 1:1 0% 5 

Trigger CDS 

interventions 

using data 

elements from 

the 

demographics 

and access 

Diagnostic and 

therapeutic 

reference 

information 

using the 

10 100% 1:1 45 9 1:1 0% 5 
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Infobutton 

Trigger CDS 

interventions 

using data 

elements from 

the lab tests 

10 100% 1:1 67.5 34 1:1 0% 5 

Trigger CDS 

interventions 

using data 

elements from 

the vital signs 

10 100% 1:1 45 7 1:1 0% 5 

Receive CDS 

interventions 

based on data 

elements in the 

problem list and  

    Medication 

list after 

incorporating a 

CCDA 

10 100% 1:1 45 7 1:1 0% 5 

Access the 

following 

attributes for a 

CDS 

intervention: 

bibliographic 

citation,  

    Developer, 

funding source, 

release/revision 

date 

10 100 1:1 45 9 1:1 0% 5 

 
Table 2. Usability testing results. 

 
The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 
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each task. Task 2 had one user deviation where the filled out more than the required fields, . 

In this case, the user went beyond the given amount of time, but still completed the task.  

 
 
EFFICIENCY 

 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time.. The tasks were all completed successfully but not within 

the given amount of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 

 
 
MAJOR FINDINGS 

 
 

The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 

on time were contributed to confusion on the screen of what all data needed to be entered 

and in what corresponding fields. Overall the users completed the tasks with few path 

deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Some users found there to be too many back arrows on some of the screens in the 

physician/provider application. Other users felt that there were too many prompts to 

acknowledge on the Alerts screen; however these prompts are required to be acknowledged 

when they are triggered. Other users noted some of the screens were busy, and stated 

having only required fields notated would improve their speed and accuracy.
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive/Thrive Provider 
 
Task 1:   Clinical Decision Support: Configure CDS interventions and reference resources 
 
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Tables> Clinical> CDS Alert Configuration 
 
Read the following to the tester: 
You are the system administrator and need to configure the Problem List CDS intervention for Diabetes care 
to the status of active. 

Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

 

Optimal Path: Select PROBLEM LIST category “Comprehensive Diabetes care- Hemoglobin A1c Control> 
Check Alert Status > Save > Back arrow 

 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 2:   Clinical Decision Support: Trigger CDS interventions using data elements from the problem       
list and access diagnostic and therapeutic reference information using the Infobutton 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Number> Enter patient account number> Go> Problem List 
 

Read the following to the tester: 

You are the provider and need to enter a diagnosis of Diabetes Type 1 (SNOWMED 46635009). Once 
entered access alerts and view additional clinical information regarding any alert triggered. 

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__45__ Seconds 

Optimal Path: New Problem> Description = Diabetes > Select Diabetes Type 1> Enter Source=Patient> 
Select Status of Active> Select Addressed date of today > Update> Select Alerts> Receive prompt of a new 
alert> Select OK > Select Comprehensive Diabetes Care alert> Select More Information > Review 
infobutton  
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 3:   Clinical Decision Support: Trigger CDS interventions using data elements from the 
medication list and access diagnostic and therapeutic reference information using the Infobutton 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Number> Enter patient account number> Go> Medication Reconciliation 
 

Read the following to the tester: 

You are the provider and need to enter a home medication of Zyrtec. Once entered access alerts and view 
additional clinical information regarding any alert triggered.  

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__45__ Seconds 

Optimal Path: Select New Home Med> Description = Zyrtec > Select ZyrTEC 10MG Oral tab> Confirm> 
Update> Select Alerts > Receive prompt of new alert > Select Medication Reconciliation Alert > Select More 
Information > Review Infobutton 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 4:   Clinical Decision Support: Trigger CDS interventions using data elements from the 
medication allergy list 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Nmber> Enter patient account number> Go> Alerts 
 

Read the following to the tester: 

You are the provider and you need to review the patient’s alerts. Select on triggered alerts to review the 
alert detail.  

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Optimal Path: From the Alerts screen> Double click Allergy List not Addressed alert > Review alert text > 
Back arrow 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 5:   Clinical Decision Support: Trigger CDS interventions using data elements from the 
demographics and access diagnostic and therapeutic reference information using the Infobutton 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Nmber> Enter patient account number> Go> Alerts 
 

Read the following to the tester: 

You are the provider and you need to review the patient’s alerts for a pediatric patient. Select on triggered 
alerts to review the alert detail.  

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Optimal Path: From the Alerts screen> Double click Weight Assessment alert > Review alert text > Select 
More Information button> Review Infobutton  
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 6:   Clinical Decision Support: Trigger CDS interventions using data elements from the lab tests 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Number> Enter patient account number> Go> Problem List 
 

Read the following to the tester: 

You are the provider and need add a diagnosis to your female patient of Patient Currently Pregnant 
(SNOWMED 77386006). Once entered access the patients alerts. 

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__45__ Seconds 

Optimal Path: Select New Problem > Description = Patient Currently Pregnant> Select Diagnosis> 
Continue >Enter source = Physician> Select Status of Active > Select Addressed date of today> Update> 
Select Alerts> Receive prompt of new alerts 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 7:   Clinical Decision Support: Trigger CDS interventions using data elements from the vital 
signs 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Nmber> Enter patient account number> Go> Alerts 
 

Read the following to the tester: 

You are the provider and you need to review the patient’s alerts for your adult patient. Select on triggered 
alerts to review the alert detail. 

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Optimal Path: From the Alerts screen> Double click Blood Pressure alert > Review alert text > Back arrow 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 8:   Clinical Decision Support: Receive CDS interventions based on data elements in the 
problem list and medication list after incorporating a CCDA  

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Number> Enter patient account number> Go> Alerts 
 

Read the following to the tester: 

You are the provider and your nurse has just informed you he/she has incorporated updated clinical 
information from your patient’s most recent transition of care document. Please access the patient’s alerts to 
see any new interventions based on this data.  

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Optimal Path: From Alerts Screen > OK new alerts for Medication Reconciliation and Diabetes Care > Note 
CDS interventions for incorporated data into the EHR.  
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 9:   Clinical Decision Support: Access the following attributes for a CDS intervention: 
bibliographic citation, developer, funding source, release/revision date 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Nmber> Enter patient account number> Go> Alerts 
 

Read the following to the tester: 

You are the provider and you need to review the patient’s alerts for your adult patient. Select on triggered 
alerts to review the alert detail 
 

Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Optimal Path: From the Alerts screen> Double click Blood Pressure alert > Review alert text and rule text 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments:  
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive Provider      
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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EXECUTIVE SUMMARY 

 
 

A usability test of Thrive Version 20 was conducted in May, 2017 in Mobile, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Clinical Information Reconciliation and 

Incorporation in the EHR Under Test (EHRUT). During the usability test, 10 healthcare 

providers matching the target demographic criteria served as participants and used the 

EHRUT in simulated, but representative tasks. 

 

This study collected performance data on 2 tasks typically conducted with Clinical 

Information Reconciliation and Incorporation on an EHR: 

1. Incorporate a CCDA and conduct reconciliation of the medications, medication  
allergies, and problems in the CCDA with the information currently in the 
patient’s record 

2. Create new CCDA with reconciled data 
 

 
During the 180 minute one-on-one usability test, each participant was greeted 

by the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give 

the participant assistance in how to complete the task. Participant screens, 

head shots and audio were recorded for subsequent analysis. 

 

 
The following types of data were collected for each participant: 
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• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 
• Number and types of errors 

 

• Path deviations 
 

• Participant’s verbalizations 
 

• Participant’s satisfaction ratings of the system 
 
 

All participant data was de-identified – no correspondence could be made from 

the identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in 

accordance with the examples set forth in the NIST Guide to the Processes 

Approach for Improving the Usability of Electronic Health Records, were used to 

evaluate the usability of the EHRUT. Following is a summary of the performance 

and rating data collected on the EHRUT. 

 

170.314(b)(2) Clinical Information Reconciliation and Incorporation  
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Incorporate a 

CCDA and 

conduct 

reconciliation of 

the 

medications, 

medication  

allergies, and 

problems in the 

CCDA with the 

information 

currently in the 

patient’s record 

10 60% 1:03:1 180 167 1:01:1 40% 4.2 

2. Create new 

CCDA with 

reconciled data 

 

10 100% 1:1 45 17 1:1 0% 5 
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The results from the System Usability Scale scored the subjective satisfaction 

with the system based on performance with these tasks to be: 77.5.  

 

 

In addition to the performance data, the following qualitative observations were 

made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
 

- Areas for improvement 
 

 
• Users found the font size to be small. 
• Move the different user options to one area of the screen. 

INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 20. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of the Clinical Information Reconciliation and 

Incorporation in the EHR Under Test (EHRUT). To this end, measures of effectiveness, 

efficiency and user satisfaction, such as time on task and reactions to screens, were 

captured during the usability testing. 

 
 

METHOD 
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PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 

participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 
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conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 

used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

2 tasks were constructed that would be realistic and representative of the kinds 
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of activities a user might do with the Clinical Information Reconciliation and 

Incorporation on this EHR: 

1. Incorporate a CCDA and conduct reconciliation of the medications, medication  
allergies, and problems in the CCDA with the information currently in the 
patient’s record 

2. Create new CCDA with reconciled data 
 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Clinical Information Reconciliation and Incorporation in Thrive.  After the 

session participants had the opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 
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Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 
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TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
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The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 

 
 

Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 2 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 
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The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
Effectiveness: 

 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 
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Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  

Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 

Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 
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material, positive impact on user performance. 

 
170.314(b)(2) Clinical Information Reconciliation and Incorporation 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Incorporate a 

CCDA and 

conduct 

reconciliation of 

the 

medications, 

medication 

allergies, and 

problems in the 

CCDA with the 

information 

currently in the 

patient’s record 

10 60% 1:03:1 180 167 1:01:1 40% 4.2 

2. Create new 

CCDA with 

reconciled data 

10 100% 1:1 45 17 1:1 0% 5 

 
Table 2. Usability testing results. 

 
The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. Task 1 had a few users hung up on the required number of steps, but all users 

were able to complete the required tasks.   
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EFFICIENCY 
 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time.. The tasks were all completed successfully but not within 

the given amount of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy. The SUS score 

averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on the 

SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 

 
 
MAJOR FINDINGS 

 
 

The users found the tasks to be easy but had some difficulty when it came to completing the 

tasks on time. The major areas where the users struggled to complete a task on time were 

contributed to the number of steps required in task 1. Overall the users completed the tasks 

with few path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Some users found there to be too many back arrows on some of the screens in the 

physician/provider application. Other users felt that there were too many steps to 

accomplish the task. Some thought it could all be done in one place, but the way our system 

is laid out requires user to go in and out of each application.  

 

APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 
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 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive/Thrive Provider 
 
Task 1:   Clinical Information Reconciliation and Incorporation: Incorporate a CCDA and conduct 
reconciliation of the medications, medication allergies, and problems in the CCDA with the 
information currently in the patient’s record 
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Number> Enter patient account number> Go> Health Information Resource 
 
Read the following to the tester: 
You are Provider and need to incorporate and reconcile your patients CCDA with their current visit 

Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

Task Time: ____________Seconds - Optimal Task Time:__120__ Seconds 

 

Optimal Path: Select Import from inbox> Select Document> Select Import > Allergies > Associate like items 
> Select imported Allergies > Import New > Select existing allergies > keep existing > Review > Reconcile > 
Select Problem List > Associate like items > Select Imported problems > Import New > Select Existing 
Problems > Keep existing > Review > Reconcile > Select Medication Reconciliation > Associate like items > 
Select imported medications > Import New > Select existing medications > Keep Existing > Review > 
Reconile 

 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/ Thrive Provider 

Task 2:   Clinical Information Reconciliation and Incorporation: Create new CCDA with reconciled 
data 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Number> Enter patient account number> Go> Reports and Attachments 
 

Read the following to the tester: 

You are the provider and need to generate a more recent CCDA after incorporation of reconciled data 

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Optimal Path: Select Med. Rec > Build Patient Summary 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments:  
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive Provider      
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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EXECUTIVE SUMMARY 

 
 

A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Computerized Physician Order Entry (CPOE) in 

the EHR Under Test (EHRUT). During the usability test, 10 healthcare providers matching the 

target demographic criteria served as participants and used the EHRUT in simulated, but 

representative tasks. 

 

This study collected performance data on 2 tasks typically conducted with Computerized 

Physician Order Entry on an EHR: 

1. Order a routine medication 
2. Order a STAT one-time IV push medication 
 

 
During the 180 minute one-on-one usability test, each participant was greeted by 

the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give the 

participant assistance in how to complete the task. Participant screens, head 

shots and audio were recorded for subsequent analysis. 

 
 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 

• Number and types of errors 
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• Path deviations 

 
• Participant’s verbalizations 

 
• Participant’s satisfaction ratings of the system 

 
 

All participant data was de-identified – no correspondence could be made from the 

identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in accordance 

with the examples set forth in the NIST Guide to the Processes Approach for 

Improving the Usability of Electronic Health Records, were used to evaluate the 

usability of the EHRUT. Following is a summary of the performance and rating data 

collected on the EHRUT. 

 

170.314(a)(1) Computerized provider order entry 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Order routine 

medication 

10 50% 1.06:1 67.5 73.6 1.17:1 50% 4 

2. Order a STAT 

one-time IV 

push 

medication 

10 20% 1.2:1 37.5 72.4 1.17:1 50% 3.5 

 
 

The results from the System Usability Scale scored the subjective satisfaction with 

the system based on performance with these tasks to be: 77.5. 

 

 

In addition to the performance data, the following qualitative observations were made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
• The different options on the screen requires the user to select something 

on one area of the screen then move the mouse to a completely different 
area of the screen to process something. This caused slight confusion in 
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the beginning. 
 

- Areas for improvement 
 
 

• Users found the font size to be small. 
• When editing orders, some of the data fields are not clearly labeled. 
• Move the different user options to one area of the screen. 
• Too many back arrows on some of the screens.
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INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of the Computerized Physician Order Entry (CPOE) in the 

EHR Under Test (EHRUT). To this end, measures of effectiveness, efficiency and user 

satisfaction, such as time on task and reactions to screens, were captured during the 

usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 
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participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 
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used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

2 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Computerized Physician Order Entry on this 

EHR: 

1. Order a routine medication 
2. Order a STAT one-time IV push medication 

 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 
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consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Computer Physician Order Entry in Thrive.  After the session participants 

had the opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 
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Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 
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implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
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the testing. 
 
 

Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
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Effectiveness: 
 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.314(a)(1) Computerized provider order entry 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Order 
routine 
medication 

10 50% 1.06:1 67.5 73.6 1.17:1 50% 4 

2. Order a 
STAT one-
time IV push 
medication 

10 20% 1.2:1 37.5 72.4 1.17:1 50% 3.5 

 
Table 2. Usability testing results. 
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The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. Task 2 had one user deviation where the user attempted to sign a medication 

order before saving. In this case, the user had to press "ok" on the prompt that appeared.  

 
 
EFFICIENCY 

 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time.. The tasks were all completed successfully but not within 

the given amount of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 

 
 
MAJOR FINDINGS 

 
 

The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 
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on time were contributed to confusion on the screen of what data to enter into a certain field 

or what option to select when searching for a STAT medication. Overall the users completed 

the tasks with few path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found there to be too many back arrows on some of the screens in the 

physician/provider application. On some of the order edit screens, the users became 

confused about the data that should be entered in the fields. Re-labeling the data fields to 

be more appropriate would improve the user's experience and allow them to complete tasks 

more quickly. Another area that needs improvement is the location of the options on the 

screen. The users had to search the screen to find what option they needed to click on in 

order to select, place, or process an order. Having all these user options in one area of the 

screen would improve their speed and accuracy
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive 
 
Task 1:   CPOE: Order a routine medication 
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Nmber> Enter patient account number> Go> OE 
 
Read the following to the tester: 
You are the provider and need to place a medication order for Lasix 40MG TAB: 20MG ORAL DAILY with 
a routine priority. Your passphrase for signing is “Passphrase1” the word Passphrase followed by the 
number one. 

Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

Task Time: ____________Seconds - Optimal Task Time:__30__ Seconds 

Task Time: ____________Seconds - Optimal Task Time: 45_Seconds 

Optimal Path: Select Departments from 'List Type'> Select Pharmacy from 'Departments' > Search for 
Lasix > Select Lasix 20mg tab> Select Move to Pending> Select Sign> Back Arrow from CM Screen- Enter 
Passpharse > Select Accept 

 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive 

Task 2:   CPOE: Order a STAT one-time IV push medication 

________________________________________________ 

Take the participant to the starting point for the task. 

Charts> Nmber> Enter patient account number> Go> OE 
 

Read the following to the tester: 

You are the provider and need to place an order for DEMEROL 50MG IV PUSH STAT as a one time (X1) 
dose. Your passphrase for signing the order is “Passphrase1”. The word Passphrase followed by the 
number one. 

 
Success: 

 Completed 
 Completed with difficulty or help::Describe below 
 Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time:__45__ Seconds 

Optimal Path: From the List Type = Departments> Description = Pharmacy (or all)>search= Dem> Select 
Demerol> Move to Pending >Review> Select Priority of STAT > Update> Sign> Accept 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive         
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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EXECUTIVE SUMMARY 

 
 

A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Computerized Physician Order Entry (CPOE) in 

the EHR Under Test (EHRUT). During the usability test, 10 healthcare providers matching the 

target demographic criteria served as participants and used the EHRUT in simulated, but 

representative tasks. 

 

This study collected performance data on 2 tasks typically conducted with Computerized 

Physician Order Entry on an EHR: 

1. Order a laboratory test 
2. Order a future scheduled laboratory test 
 

 
During the 180 minute one-on-one usability test, each participant was greeted by 

the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give the 

participant assistance in how to complete the task. Participant screens, head 

shots and audio were recorded for subsequent analysis. 

 

 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 
• Number and types of errors 
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• Path deviations 

 
• Participant’s verbalizations 

 
• Participant’s satisfaction ratings of the system 

 
 

All participant data was de-identified – no correspondence could be made from the 

identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in accordance 

with the examples set forth in the NIST Guide to the Processes Approach for 

Improving the Usability of Electronic Health Records, were used to evaluate the 

usability of the EHRUT. Following is a summary of the performance and rating data 

collected on the EHRUT. 

 

170.314(a)(1) Computerized provider order entry 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Order a 

laboratory test 

10 20% 1.07:1 22.5 45.2 1.03:1 30% 4.7 

2. Order a 

future 

scheduled 

laboratory test 

10 20% 1.03:1 22.5 42.3 1.26:1 40% 4.9 

 
 

The results from the System Usability Scale scored the subjective satisfaction with 

the system based on performance with these tasks to be: 77.5. 

 

 

In addition to the performance data, the following qualitative observations were made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
• The different options on the screen requires the user to select something 

on one area of the screen then move the mouse to a completely different 
area of the screen to process something. This caused slight confusion in 
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the beginning. 
 

- Areas for improvement 
 
 

• Users found the font size to be small. 
• When editing orders, some of the data fields are not clearly labeled. 
• Move the different user options to one area of the screen. 
• Too many back arrows on some of the screens.
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INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of the Computerized Physician Order Entry (CPOE) in the 

EHR Under Test (EHRUT). To this end, measures of effectiveness, efficiency and user 

satisfaction, such as time on task and reactions to screens, were captured during the 

usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 
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participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 
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used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

2 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Computerized Physician Order Entry on this 

EHR: 

1. Order a laboratory test 
2. Order a future scheduled laboratory test 

 
Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 
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the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Computer Physician Order Entry in Thrive.  After the session participants 

had the opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 
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questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 



Page 10 of 24 
 

 

system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 
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Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
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Effectiveness: 
 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.314(a)(1) Computerized provider order entry 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Order a 
laboratory 
test 

10 20% 1.07:1 22.5 45.2 1.03:1 30% 4.7 

2. Order a 
future 
scheduled 
laboratory 
test 

10 20% 1.03:1 22.5 42.3 1.26:1 40% 4.9 
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Table 2. Usability testing results. 
 

The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. Task 2 had one user deviation where the user had an issue figuring out which 

time feature to utilize. This added one extra step where the user had to change the radio 

button from am to time.  

 
 
EFFICIENCY 

 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time. Tasks 2 was time intensive tasks because the users 

were required to manually enter the data in the fields. Some users were slower at 

completing the task because of the significant amount of data entry required, which is the 

nature of ordering non-formulary medications. The tasks were all completed successfully but 

not within the given amount of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 
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MAJOR FINDINGS 

 
 

The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 

on time were contributed to confusion on the screen of what data to enter into a certain field 

or what option to select when future scheduling a test. Overall the users completed the tasks 

with few path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found there to be too many back arrows on some of the screens in the 

physician/provider application. On some of the order edit screens, the users became 

confused about the data that should be entered in the fields. Re-labeling the data fields to 

be more appropriate would improve the user's experience and allow them to complete tasks 

more quickly. Another area that needs improvement is the location of the options on the 

screen. The users had to search the screen to find what option they needed to click on in 

order to select, place, or process an order. Having all these user options in one area of the 

screen would improve their speed and accuracy
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive 

Task 1:   CPOE: Order a laboratory test 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Nmber> Enter patient account number> Go> OE 
 
Read the following to the tester: 
You are the provider and need to order a POTASSIUM lab order for today at noon.  Your passphrase for 
signing is “Passphrase1”.  
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time: 15_Seconds 
Optimal Path: List Type = Departments> Description = Lab(or all)>search= Pot> Select POTASSIUM > 
Sign> Accept 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive  

Task 2:   CPOE: Order a future scheduled laboratory test 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 

Charts> Nmber> Enter patient account number> Go> OE 

Read the following to the tester: 

You are the provider and need to order a Magnesium lab order to be performed at the hospital tomorrow 
morning (at 8 am). Your passphrase for signing is “Passphrase1”. 
 

Success: 

    Completed 

    Completed with difficulty or help::Describe below 

    Not completed 

Comments: 

 

Task Time: ____________Seconds - Optimal Task Time: 15_Seconds 

Optimal Path: List Type = Departments> Description = Lab(or all)>search= Mag> Select MAGNESIUM> 
Move to Pending> Double click  MAGNESIUM> Select Calendar Icon in Scheduled Date Field> Select 
Date> Select Time< 0800> Select  Update> Sign> Accept 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive         
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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EXECUTIVE SUMMARY 

 
 

A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Computerized Physician Order Entry (CPOE) in 

the EHR Under Test (EHRUT). During the usability test, 10 healthcare providers matching the 

target demographic criteria served as participants and used the EHRUT in simulated, but 

representative tasks. 

 

This study collected performance data on 1 task typically conducted with Computerized 

Physician Order Entry on an EHR: 

1. Order a radiology test 
 
 

During the 180 minute one-on-one usability test, each participant was greeted by 

the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give the 

participant assistance in how to complete the task. Participant screens, head 

shots and audio were recorded for subsequent analysis. 

 

 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 
• Number and types of errors 

 
• Path deviations 
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• Participant’s verbalizations 

 
• Participant’s satisfaction ratings of the system 

 
 

All participant data was de-identified – no correspondence could be made from the 

identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in accordance 

with the examples set forth in the NIST Guide to the Processes Approach for 

Improving the Usability of Electronic Health Records, were used to evaluate the 

usability of the EHRUT. Following is a summary of the performance and rating data 

collected on the EHRUT. 

 

170.314(a)(1) Computerized provider order entry 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Order a 

radiology test 

10 10% 1.02:1 37.5 78.5 1.07:1 20% 3.5 

 
 

The results from the System Usability Scale scored the subjective satisfaction with 

the system based on performance with these tasks to be: 77.5. 

 

 

In addition to the performance data, the following qualitative observations were made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
• The different options on the screen requires the user to select something 

on one area of the screen then move the mouse to a completely different 
area of the screen to process something. This caused slight confusion in 
the beginning. 

 
- Areas for improvement 

 

 
• Users found the font size to be small. 
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• When editing orders, some of the data fields are not clearly labeled. 
• Move the different user options to one area of the screen. 
• Too many back arrows on some of the screens.
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INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of the Computerized Physician Order Entry (CPOE) in the 

EHR Under Test (EHRUT). To this end, measures of effectiveness, efficiency and user 

satisfaction, such as time on task and reactions to screens, were captured during the 

usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 
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participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 
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used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

1 task was constructed that would be realistic and representative of the kinds of 

activities a user might do with the Computerized Physician Order Entry on this 

EHR: 

1. Order a radiology test 
 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 
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the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Computer Physician Order Entry in Thrive.  After the session participants 

had the opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 
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questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 
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system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 
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Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
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Effectiveness: 
 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.314(a)(1) Computerized provider order entry 
Measure 
Task ↓ 

Number 
of Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/
Optimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/
Optimal) 

Mean  Mean  

1. Order a 
radiology 
test 

10 10% 1.02:1 37.5 78.5 1.07:1 20% 3.5 

 
Table 2. Usability testing results. 

 
The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 
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system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. Task 1 had one user deviation where the user didn’t click into the free text field to 

answer a question. This added 2 steps to the pathway because the user repeated steps 

before figuring out the free text box. 

 
 
EFFICIENCY 

 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time. Task 1 was a time intensive task because the users were 

required to manually enter the data in the fields. Some users were slower at completing the 

task because of the significant amount of data entry required, which is the nature of ordering 

non-formulary medications. The tasks were all completed successfully but not within the 

given amount of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 

 
 
MAJOR FINDINGS 
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The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 

on time were contributed to confusion on the screen of what data to enter into a certain field 

or what option to select when searching a certain test. Overall the users completed the tasks 

with few path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found there to be too many back arrows on some of the screens in the 

physician/provider application. On some of the order edit screens, the users became 

confused about the data that should be entered in the fields. Re-labeling the data fields to 

be more appropriate would improve the user's experience and allow them to complete tasks 

more quickly. Another area that needs improvement is the location of the options on the 

screen. The users had to search the screen to find what option they needed to click on in 

order to select, place, or process an order. Having all these user options in one area of the 

screen would improve their speed and accuracy
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive 

Task 1:   CPOE: Order a radiology procedure 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Nmber> Enter patient account number> Go> OE 
 
You are the provider and need to order a Radiology procedure Chest 2 VIEW    to be performed today at 
1200 for chest pain.  In OE questions you will need to fill in that the patient's 'Mode of arrival? - 
Transportation via wheelchair', there is 'Patient on IV? - No IV' and 'Patient on O2? - No O2'. Your 
passphrase for signing is “Passphrase1”. 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_25_Seconds 
Optimal Path:.  List Type = Departments> Description = Rad(or all)>search= CHE> Select Chest 2 View> 
Move to Pending> Review> Double Click Chest 2 View> Select Calendar Icon in Scheduled Date Field> 
Select Date> Type 'Transportation via Wheelchair in OE Question 1 > Type 'No IV' in OE Question 2> Type 
'No O2' in OE Question 3> Save > Back Arrow> Sign> Enter Passphrase> Accept 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive         
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama 

by Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Demographics in the EHR Under Test 

(EHRUT). During the usability test, 10 healthcare providers matching the target demographic 

criteria served as participants and used the EHRUT in simulated, but representative tasks. 

 

This study collected performance data on 2 tasks typically conducted on an EHR: 

1. Document the patient’s demographic information  
2. Document the patient’s sexual orientation and gender 

 
During the 180 minute one-on-one usability test, each participant was greeted 

by the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give 

the participant assistance in how to complete the task. Participant screens, 

head shots and audio were recorded for subsequent analysis. 

 

 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations 
 

• Participant’s satisfaction ratings of the system 
 
 

All participant data was de-identified – no correspondence could be made from 
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the identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in 

accordance with the examples set forth in the NIST Guide to the Processes 

Approach for Improving the Usability of Electronic Health Records, were used to 

evaluate the usability of the EHRUT. Following is a summary of the performance 

and rating data collected on the EHRUT. 

 

170.315(a)(6) Problem list 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1. Document 

the patient’s 

demographic 

information 

10 80% 1.07:1 90 66 1.17:1 20% 3.25 

2. Document 

the patient’s 

sexual 

orientation and 

gender 

10 90% 1:1 90 48.3 1.01:1 10% 3.5 

 
 

The results from the System Usability Scale scored the subjective satisfaction 

with the system based on performance with these tasks to be: 77.5.  

 

 

In addition to the performance data, the following qualitative observations were 

made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
• The different options on the screen requires the user to select 

something on one area of the screen then move the mouse to a 
completely different area of the screen to process something. This 
caused slight confusion in the beginning. 

 
- Areas for improvement 
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• Users found the font size to be small. 
• The screen was very busy 
• When entering multiple races, users found the selection screen was 

opposite than any other selection screen they had used 

INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of Demographics in the EHR Under Test (EHRUT). To 

this end, measures of effectiveness, efficiency and user satisfaction, such as time on task 

and reactions to screens, were captured during the usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 
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All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 

participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 

1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 
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During the usability test, participants interacted with one EHR. Each participant 

used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

2 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Demographics on this EHR: 

1. Document the patient’s demographic information  
2. Document the patient’s sexual orientation and gender 

 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 



Page 7 of 23 
 

 

consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Demographics in Thrive.  After the session participants had the opportunity 

to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 
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Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 
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implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
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the testing. 
 
 

Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
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Effectiveness: 
 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.315(a)(5) Demographics 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1. Document 
the patient’s 
demographi
c 
information 

10 80% 1.07:1 90 66 1.17:1 20% 3.25 

2. Document 
the patient’s 
sexual 
orientation 
and gender 

10 90% 1:1 90 48.3 1.01:1 10% 3.5 
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Table 2. Usability testing results. 
 

The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data entry options. There were no major path deviations that caused a 

user not to complete a task. The users effectively used the system to complete each task. 

Task 2 had one user where the user forgot what menu option to select to enter in sexual 

history, which caused one extra step.  

 
 
EFFICIENCY 

 
 

Based on the task times, all users were successful in completing all tasks within the optimal 

time. Task 1 was a time intensive task because the users were required to manually enter 

the data in the fields. Some users were slower at completing the task because of the 

significant amount of data entry required, which is the nature of patient demographic 

information. The tasks were all completed successfully but not within the given amount of 

time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 
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MAJOR FINDINGS 

 
 

The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 

on time were contributed to confusion on the screen of what data to enter into a certain field 

or how the screen was laid out when entering multiple races. Overall the users completed 

the tasks with few path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found the font size to be too small on the screens in the patient demographics 

application. On some of the edit screens, the users became confused about the layout of the 

screen. Modifying the layout to be consistent with the other data entry screens would 

improve the user's experience and allow them to complete tasks more quickly. Another area 

that needs improvement is the location of the options on the screen. The users noted that 

the screen was very busy which caused some confusion when entering data. Finding a way 

to streamline the screen would improve their speed and accuracy. 
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive/Thrive Provider 
 
Task 1:   Demographics: Document the patient’s demographic information 
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
HBM> Key in acct #> Census> Go> Patient 
 
The patient has presented to the facility. You have asked them their Race, Sex, Ethnicity and Preferred 
language. Please Document that the patient is  

i. Asian (2028-9) AND White (2106-3) 
ii. Not Hispanic or Latino (2186-5) 
iii. English (en) 
iv.  Unknown (UNK) 

 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_60 __Seconds 
Optimal Path: Select Race Plus Sign- Select Asian- Select Caucasian- Back Arrow- Select Lookup for 
Ethnicity- Enter Non Hispanic or Latino- Select Lookup for Language- Select English- Key in U in Race 
Field- Ensure it sticks. 
 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 2:   Demographics: Document the patient’s sexual orientation and gender 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
HBM> Key in acct #> Census> Go> Clinical 
 
The Patient has been admitted to the facility and you need to document their sexual orientation and gender. 
Please document that the patient identifies as male and is straight or heterosexual.  
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_60 __Seconds 
Optimal Path: Select Immunizations- Select Health History- Select Add New- Select Sexual- Select Straight 
or Heterosexual radio button- Select identifies as male radio button- Save.  
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive          
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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EXECUTIVE SUMMARY 

 
 

A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama 

by Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Electronic Prescribing) in the EHR Under Test 

(EHRUT). During the usability test, 10 healthcare providers matching the target demographic 

criteria served as participants and used the EHRUT in simulated, but representative tasks. 

 

This study collected performance data on 4  tasks typically conducted on an EHR: 

1. Electronically prescribe a generic medication 
2. Electronically prescribe a name brand medication 
3. Electronically prescribe a refill for a patients medication 
4. Electronically prescribe a medication with a note to the pharmacist 
 

 
During the 180 minute one-on-one usability test, each participant was greeted 

by the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give 

the participant assistance in how to complete the task. Participant screens, 

head shots and audio were recorded for subsequent analysis. 

 

 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 
• Number and types of errors 

 
• Path deviations 
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• Participant’s verbalizations 
 

• Participant’s satisfaction ratings of the system 
 
 

All participant data was de-identified – no correspondence could be made from 

the identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in 

accordance with the examples set forth in the NIST Guide to the Processes 

Approach for Improving the Usability of Electronic Health Records, were used to 

evaluate the usability of the EHRUT. Following is a summary of the performance 

and rating data collected on the EHRUT. 

 

170.314(b)(3) Electronic prescribing 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1 E-scribe a 

generic 

medication 

10 70% 1:1 90 96.25 1.01:1 10% 5 

2. E-Scribe a 

name brand 

medication 

10 100% 1:1 97.5 47.8 1:1 0% 5 

3. E-Scribe a 

refill for a 

medication 

10 100% 1:1 97.5 37.1 1:1 0% 5 

4. E-Scribe a 

medication with 

a note to 

pharmacy 

10 90% 1:1 90 66.8 1:1 0% 5 

 
 

The results from the System Usability Scale scored the subjective satisfaction 

with the system based on performance with these tasks to be: 77.5.  

 

 

In addition to the performance data, the following qualitative observations were 

made: 

 

 
- Major findings 
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• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
• The different options on the screen requires the user to select 

something on one area of the screen then move the mouse to a 
completely different area of the screen to process something. This 
caused slight confusion in the beginning. 

 
- Areas for improvement 

 

 
• Users found the font size to be small. 
• When editing orders, some of the data fields are not clearly labeled. 
• Move the different user options to one area of the screen. 

INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of Electronic Prescribing in the EHR Under Test 

(EHRUT). To this end, measures of effectiveness, efficiency and user satisfaction, such as 

time on task and reactions to screens, were captured during the usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 
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their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 

participants by characteristics, including demographics, professional experience, 

computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst  
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 
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where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 

used the system in the same location, and was provided with the same 

instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

4 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Electronic Prescribing on this EHR: 

1. Electronically prescribe a generic medication 
2. Electronically prescribe a name brand medication 
3. Electronically prescribe a refill for a patients medication 
4. Electronically prescribe a medication with a note to the pharmacist 

 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 
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may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 

 

The participants were given a 15 minute education session to orient them on how to use and 

interact with the Electronic Prescribing in the Thrive.  After the session participants had the 

opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
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For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 

each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  
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The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 

 
TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 

1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
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therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 

 
 

Following the procedural instructions, the administrator gave the following instructions: 
 

For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 
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The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
Effectiveness: 

 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 
The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.314(b)(3) Electronic prescribing 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1 E-scribe a 
generic 
medication 

10 70% 1:1 90 96.25 1.01:1 10% 5 

2. E-Scribe a 
name brand 
medication 

10 100% 1:1 97.5 47.8 1:1 0% 5 

3. E-Scribe a 
refi l l for a 
medication 

10 100% 1:1 97.5 37.1 1:1 0% 5 
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4. E-Scribe a 
medication 
with a note 
to pharmacy 

10 90% 1:1 90 66.8 1:1 0% 5 

 
Table 2. Usability testing results. 

 
The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. Task 1 had one user deviation where the user attempted to search a medication 

order selecting the new prescription option. This added an extra step to the process. Task 3 

had one user deviation where the user forgot to add a frequency which added some time to 

the task.  

 
 
EFFICIENCY 

 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time. Task 4 was a time intensive task because the users were 

required to manually enter the data in the fields. Some users were slower at completing the 

task because of the significant amount of data entry required, which is the nature of filling 

out prescriptions. The tasks were all completed successfully but not within the given amount 

of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 



Page 14 of 25 
 

 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 

 
 
MAJOR FINDINGS 

 
 

The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 

on time were contributed to confusion on the screen of what data to enter into a certain field 

or what option to use for note to pharmacy. Overall the users completed the tasks with few 

path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found the font size to be too small on the screens in the physician/provider 

application. On some of the order edit screens, the users became confused about the data 

that should be entered in the fields. Re-labeling the data fields to be more appropriate would 

improve the user's experience and allow them to complete tasks more quickly. Another area 

that needs improvement is the location of the options on the screen. The users had to 

search the screen to find what option they needed to click on in order to select, place, or 

process an order. Having all these user options in one area of the screen would improve 

their speed and accuracy. 

  



Page 15 of 25 
 

 

APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive/Thrive Provider  
 
Task 1:   Electronic Prescribing: Prescribe a generic medication 
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts – Search By Patient – Key In account Number- Go – Prescription Entry. 
 
Read the following to the tester: 
The provider is prescribing a new medication Lisinopril 2.5MG TABLET 
Daily, by mouth, with no refills, dispense quantity 30 sending electronically to Druglix pharmacy for this 
patient, physician ok’s generic substitution. 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:60____Seconds 
Optimal Path:,Alpha search medication "LIS" – All Meds – Click on Lisinopril 2.5 MG Oral Tablet – 
Continue – Click in Dose field - Enter dose - Route drop down - select By mouth or Oral - Click in Dispense 
Quantity field - Enter 30 - Select in Refills field - Enter 1 - Click the radio button next to Dispense as Written - 
Click the radio button next to Electronic - Pharmacy drop down - Select a pharmacy – Save – Process 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 2:   Electronic Prescribing: Prescribe a brand name medication 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts- Search By Number – Key in Account Number- Go-Prescription Entry 
 
Read the following to the tester: 
The provider is prescribing a new medication Requip 4MG tablet , Daily, By Mouth, 1 refill, 30 dispensed 
quantity for the patient. The patient wishes to get this prescription sent electronically to Druglix pharmacy. 
The physician also specifies Dispense as Written. 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:65____Seconds 
Optimal Path: Alpha search medication "REQ"– All Meds – Click on Requip 4MG Tablet – Continue – Click 
in Dose field - Enter dose - Route drop down - select By mouth - Click in Dispense Quantity field - Enter 30 - 
Select in Refills field - Enter 1 - Click the radio button next to Dispense as Written - Click the radio button 
next to Electronic - Pharmacy drop down - Select pharmacy– Save – Process 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 3:   Electronic Prescribing: Prescribe a medication which is a refill for one of the patients 
current prescriptions 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 

Charts – Search by Number – Key In Account Number- Go- Prescription Entry 

Read the following to the tester: 

The provider wishes to renew the medication Lisiniprol 2.5 MG , renew this medication change the earliest 
refill date to a month from now, 1 refill, 30 dispensed quantity, Generic Substitution and send electronically 
to Druglix pharmacy. 

Success: 

    Completed 

   Completed with difficulty or help::Describe below 

   Not completed 

Comments: 

Task Time: ____________Seconds - Optimal Task Time:_65___Seconds 

Optimal Path: Select Medication Lisiniprol 2.5"– Select Renew –- Enter dose - Route drop down - select By 
mouth or Oral - Click in Dispense Quantity field - Enter 30 - Select in Refills field - Enter 1 – Change date of 
earliest refill to a month from today- Click the radio button next to Dispense as Written - Click the radio 
button next to Electronic - Pharmacy drop down - Select a pharmacy – Save – Process 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 4:   Electronic Prescribing: Prescribe a medication with a note to pharmacy 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts – Search by Patient- Key In account number- Go – Prescription entry. 
 
Read the following to the tester: 
The provider would like to prescribe a new medication Xifaxan 200MG Tablet, By Mouth, Daily. 30 quantity 
dispensed with 1 refill, brand name only.  Add a Note to Pharmacy: "Please counsel patient on side effects" 
and send this prescription electronically to Druglix pharmacy.  
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_60__Seconds 
Optimal Path: 20 clicks Alpha search medication "XIFAX" – All Meds – Click on Xifaxan 200MG Tablet – 
Continue – Click in Dose field - Enter dose - Route drop down - select By mouth or Oral - Click in Dispense 
Quantity field - Enter 30 - Select in Refills field - Enter 1 - Click the radio button next to Dispense as Written - 
Click the radio button next to Electronic - Pharmacy drop down - Select a pharmacy - Click in the Note to 
Pharmacy field - Enter text "Please counsel patient on side effects"– Save – Process 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 

 



Page 25 of 25 
 

 

Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive          
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Implantable device list in the EHR Under Test 

(EHRUT). During the usability test, 10 healthcare providers matching the target demographic 

criteria served as participants and used the EHRUT in simulated, but representative tasks. 

 

This study collected performance data on 3 tasks typically conducted on an EHR: 

1. Identify the patient’s active implantable device  
2. Modify the device type on the patient’s active implantable device 
3. Review the device history of the patient’s active implantable device 

 
During the 180 minute one-on-one usability test, each participant was greeted by 

the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give the 

participant assistance in how to complete the task. Participant screens, head 

shots and audio were recorded for subsequent analysis. 

 
 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations 
 

• Participant’s satisfaction ratings of the system 
 
 

All participant data was de-identified – no correspondence could be made from the 
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identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in accordance 

with the examples set forth in the NIST Guide to the Processes Approach for 

Improving the Usability of Electronic Health Records, were used to evaluate the 

usability of the EHRUT. Following is a summary of the performance and rating data 

collected on the EHRUT. 

 

170.315(a)(14) Implantable device l ist 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1. Identify the 

patient’s active 

implantable 

device 

10 100% 1:1 37.5 20.2 1:1 10% 5 

2. Modify the 

device type on 

the patient’s 

active 

implantable 

device 

10 100% 1:1 37.5 19.8 1:1 0% 3.8 

3. Review the 

device history 

of the patient’s 

active 

implantable 

device 

10 80% 1.03:1 37.5 24.9 1.01:1 10% 3.6 

 
 

The results from the System Usability Scale scored the subjective satisfaction with 

the system based on performance with these tasks to be: 77.5. 

 

 

In addition to the performance data, the following qualitative observations were made: 

 

 
 
 
 
- Major findings 
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• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
 

- Areas for improvement 
 
 

• Users found the font size to be small. 
• Users found the screens to be very busy and hard to read. 
• Users found certain options hard to find
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INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of Implantable device list in the EHR Under Test 

(EHRUT). To this end, measures of effectiveness, efficiency and user satisfaction, such as 

time on task and reactions to screens, were captured during the usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 

participants by characteristics, including demographics, professional experience, 
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computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 

used the system in the same location, and was provided with the same 
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instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

3 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Problem list on this EHR: 

1. Identify the patient’s active implantable device  
2. Modify the device type on the patient’s active implantable device 
3. Review the device history of the patient’s active implantable device 

 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 
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The participants were given a 15 minute education session to orient them on how to use and 

interact with the Implantable device list in the Thrive.  After the session participants had the 

opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 
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each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 
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TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 
1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 

 
 

Following the procedural instructions, the administrator gave the following instructions: 
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For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 



Page 12 of 25 
 

 

Effectiveness: 
 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.315(a)(14) Implantable device l ist 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1. Identify 
the patient’s 
active 
implantable 
device 

10 100% 1:1 37.5 20.2 1:1 10% 5 
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2. Modify 
the device 
type on the 
patient’s 
active 
implantable 
device 

10 100% 1:1 37.5 19.8 1:1 0% 3.8 

3. Review 
the device 
history of 
the patient’s 
active 
implantable 
device 

10 80% 1.03:1 37.5 24.9 1.01:1 10% 3.6 

 
 

Table 2. Usability testing results. 
 

The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. Task 3 had one user deviation where the user could not find the history button so 

they backed out of the screen once before finding it, this added two extra steps to the 

process.  

 
 
EFFICIENCY 

 
 

Based on the task times, some of the users failed the task because they were unable to 

complete it within the optimal time. Tasks 2 and 3 were time intensive task because the 

users had to read information from a busy screen, which slowed a few of the users down. 

The tasks were all completed successfully but not all within the given amount of time. 

 
 
 
SATISFACTION 
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Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 

 
 
MAJOR FINDINGS 

 
 

The users found the tasks to be easy to very easy but had some difficulty when it came to 

completing the tasks on time. The major areas where the users struggled to complete a task 

on time were contributed to confusion on the screen of what data to read from  a certain field 

or what option to select to locate history. Overall the users completed the tasks with few 

path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found the font size to be too small on the screens in the patient demographics 

application. On some of the edit screens, the users became confused about the layout of the 

screen. Modifying the layout to be consistent with the other data entry screens would 

improve the user's experience and allow them to complete tasks more quickly. Another area 

that needs improvement is the location of the options on the screen. The users noted that 

the screen was very busy which caused some confusion when entering data. Finding a way 

to streamline the screen would improve their speed and accuracy. 
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 
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Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive/Thrive Provider  
 
Task 1:   Implantable Device List: Identify the patient’s active implantable device  
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Nmber> Enter patient account number> Go> Health History tab 
 
The patient has had multiple implantable devices added to their history. Identify the description and brand 
name of the active implantable device 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_25 __Seconds 
Optimal Path: Select Implantable Device> Read the Description and Brand Name of Active Device out loud 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider  

Task 2:   Implantable Device List: Modify the device type on the patient’s active implantable device 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Nmber> Enter patient account number> Go> Health History tab 
 
The patient has had multiple implantable devices added to their history. Change the device type of the 
active implantable device to graft and update your changes. 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_25 __Seconds 
Optimal Path: Select Implantable Device> Select Device Type- Select Graft- Update 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 3:   Implantable Device List: Review the device history of the patient’s active implantable 
device 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
Charts> Nmber> Enter patient account number> Go> Health History tab 
 
The patient has had multiple implantable devices added to their history. Review the device history of the 
active implantable device and identify the old value of the device type. 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:_25 __Seconds 
Optimal Path: Select Implantable Device> Select Device History- Read aloud the old value of the device 
type 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

 

Comments: 

 

Observed Errors and Verbalizations: 

 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive         
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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A usability test of Thrive Version 19 was conducted in October, 2016 in Fairhope, Alabama by 

Evident. The purpose of this test was to test and validate the usability of the current user 

interface, provide evidence of usability of the Problem list in the EHR Under Test (EHRUT). 

During the usability test, 10 healthcare providers matching the target demographic criteria 

served as participants and used the EHRUT in simulated, but representative tasks. 

 

This study collected performance data on 3 tasks typically conducted on an EHR: 

1. Identify the patient’s active problems (diagnosis) 
2. Enter a new problem (diagnosis) 
3. Modify an existing problem (diagnosis) 

 
During the 180 minute one-on-one usability test, each participant was greeted by 

the administrator and asked to review and sign an informed consent/release 

forms (included in Appendices 1 and 2); they were instructed that they could 

withdraw at any time. Participants did not have prior experience with the EHR. 

The administrator introduced the test, and instructed participants to complete a 

series of tasks (given one at a time) using the EHRUT. During the testing, the 

administrator timed the test and, along with the data logger(s) recorded user 

performance data on paper and electronically. The administrator did not give the 

participant assistance in how to complete the task. Participant screens, head 

shots and audio were recorded for subsequent analysis. 

 
 
The following types of data were collected for each participant: 

 
 

• Number of tasks successfully completed within the allotted time 
without assistance 

 
• Time to complete the tasks 

 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations 
 

• Participant’s satisfaction ratings of the system 
 
 

All participant data was de-identified – no correspondence could be made from the 
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identity of the participant to the data collected. Following the conclusion of the 

testing, participants were asked to complete a post-test questionnaire and were 

compensated with $75 for their time. Various recommended metrics, in accordance 

with the examples set forth in the NIST Guide to the Processes Approach for 

Improving the Usability of Electronic Health Records, were used to evaluate the 

usability of the EHRUT. Following is a summary of the performance and rating data 

collected on the EHRUT. 

 

170.315(a)(6) Problem list 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1 Identify the 

patient’s active 

problems 

(diagnosis) 

10 100% 1:1 45 6.2 1:1 0% 5 

2 Enter a new 

problem 

(diagnosis) 

10 100% 1.01:1 90 28.9 1:1 10% 4.9 

3. Modify an 

existing 

problem 

(diagnosis) 

10 100% 1:1 90 23.5 1:1 20% 4.9 

 
 

The results from the System Usability Scale scored the subjective satisfaction with 

the system based on performance with these tasks to be: 77.5. 

 

 

In addition to the performance data, the following qualitative observations were made: 

 

- Major findings 
 
 

• The users found it was user friendly and easy to use. 
• The work flow was in a logical order. 
• After doing repeated steps on various tasks, the users were much 

quicker at going through the system completing tasks. 
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- Areas for improvement 
 

 
• Users found the font size to be small. 
• There are multiple ways to perform one task, which can be confusing 
• Look up process can be cumbersome 



Page 5 of 25 
 

 

INTRODUCTION 
 
 

The EHRUT tested for this study was Thrive Version 19. Designed to present medical 

information to healthcare providers in healthcare facilities, the EHRUT consists of a 

complete suite of integrated products; all designed to work in concert with each other and 

provide community hospitals with a complete electronic medical record (EMR). Thrive is a 

health information solution that was completely designed and developed by Evident. It 

provides all hospital key departments with a single database. Thrive promotes improved 

patient care, increased patient safety, and better patient outcomes. The usability testing 

attempted to represent realistic exercises and conditions.  

 

The purpose of this study was to test and validate the usability of the current user interface, 

and provide evidence of usability of Problem list in the EHR Under Test (EHRUT). To this 

end, measures of effectiveness, efficiency and user satisfaction, such as time on task and 

reactions to screens, were captured during the usability testing. 

 
 

METHOD 
 
 
 

PARTICIPANTS 
 
 

A total of 10 participants tested the EHRUT. Participants in the test were nurse practitioners 

and registered nurses. Participants were recruited by Evident and were compensated $75 for 

their time. In addition, participants had no direct connection to the development of or 

organization producing the EHRUT. Participants were not from the testing or supplier 

organization. Participants were given the opportunity to have the same orientation and level 

of training as the actual end users would have received. 

 

All 10 recruited participants participated in the usability test. Recruited participants had a 

mix of backgrounds and demographic characteristics. The following is a table of 

participants by characteristics, including demographics, professional experience, 
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computing experience and user needs for assistive technology. Participant names were 

replaced with Participant IDs so that an individual's data cannot be tied back to individual 

identities. 

  
Part 
ID 

 
 

Gender 

 
 

Age 

 
 

Education 

 
Occupation/ 

role 

 
Professional 
Experience 

Computer 
Experience 
(in years) 

 
Product 

Experience 

Assistive 
Technology 

Needs 
1 N001 Female 60-69 College- NP NP Less than 3 yr More than 10 None None 
2 N002 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
3 N003 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
4 N004 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
5 N005 Female 23-39 College- BS RN More than 3 yr More than 10 None None 
6 N006 Female 23-39 College- BA Clinical 

Analyst 
Less than 1 yr More than 10 None None 

7 N007 Male 20-39 College- BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

8 N008 Female 30-39 College LPN More than 1 yr More than 10 None None 
9 N009 Male 20-29 College- BS Clinical 

Analyst 
Less than 1 yr More than 10 None None 

10 N010 Female 30-39 College-BA Clinical 
Analyst 

Less than 1 yr More than 10 None None 

 
 
 
 

Participants were scheduled for 45 minute sessions with 10 minutes in between each session 

for debrief by the administrator(s) and data logger(s), and to reset systems to proper test 

conditions. A spreadsheet was used to keep track of the participant schedule, and included 

each participant’s demographic characteristics. 

 
STUDY DESIGN 

 
Overall, the objective of this test was to uncover areas where the application 

performed well – that is, effectively, efficiently, and with satisfaction – and areas 

where the application failed to meet the needs of the participants. The data from 

this test may serve as a baseline for future tests with an updated version of the 

Thrive and/or comparison with other EHRs provided the same tasks are used. In 

short, this testing serves as both a means to record or benchmark current usability, 

but also to identify areas where improvements must be made. 

 
 

During the usability test, participants interacted with one EHR. Each participant 

used the system in the same location, and was provided with the same 
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instructions. The system was evaluated for effectiveness, efficiency and 

satisfaction as defined by measures collected and analyzed for each participant: 

 
• Number of tasks successfully completed within the allotted time 

without assistance 
 

• Time to complete the tasks 
 

• Number and types of errors 
 

• Path deviations 
 

• Participant’s verbalizations (comments) 
 

• Participant’s satisfaction ratings of the system 
 
 

Additional information about the various measures can be found in Section 3.9 on Usability 

Metrics. 

 
 
TASKS 

 
 

3 tasks were constructed that would be realistic and representative of the kinds 

of activities a user might do with the Problem list on this EHR: 

1. Identify the patient’s active problems (diagnosis) 
2. Enter a new problem (diagnosis) 
3. Modify an existing problem (diagnosis) 

 
 

Tasks were selected based on their frequency of use, criticality of function, and those that 

may be troublesome for users.The tasks are prioritized in accordance with the risk 

associated with user errors.

 
PROCEDURE 

 
 

Upon arrival, participants were greeted and their identity was verified and matched with a 

name on the participant schedule.  Each participant reviewed and signed an informed 

consent and release form (see Appendix 2).  A representative from the test team witnessed 

the participant’s signature. 
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The participants were given a 15 minute education session to orient them on how to use and 

interact with the Problem List in the Thrive.  After the session participants had the 

opportunity to ask questions. 

 

To ensure that the test ran smoothly, two staff members participated in this test, 

the usability administrator and the data logger. The usability testing staff 

conducting the test was experienced usability practitioners with 7 years’ 

experience. The administrator moderated the session including administering 

instructions and tasks. The administrator also monitored task times, obtained 

post-task rating data, and took notes on participant comments. A second person 

served as the data logger and took notes on task success, path deviations, 

number and type of errors, and comments. 

 

Participants were instructed to perform the tasks (see specific 

instructions below): 

 
• As quickly as possible making as few errors and deviations as 

possible. 

• Without assistance; administrators were allowed to give 
immaterial guidance and clarification on tasks, but not 
instructions on use. 

• Without using a think aloud technique. 
 
 

For each task, the participants were given a written copy of the task. Task timing 

began once the administrator finished reading the question. The task time was 

stopped once the participant indicated they had successfully completed the task. 

Scoring is discussed below in Section 3.9. 

 

Following the session, the administrator gave the participant the post-test 

questionnaire (see Appendix 5), compensated them for their time, and thanked 
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each individual for their participation. Participants' demographic information, task 

success rate, time on task, errors, deviations, verbal responses, and post-test 

questionnaire were recorded into a spreadsheet. Participants were thanked for 

their time and compensated. Participants signed a receipt and acknowledgement 

form (see Appendix 3) indicating that they had received the compensation. 

 
TEST LOCATION 
 

The test facility included a classroom for application education and a quiet testing 

room with a table and a computer for the participant. Only the participant and 

administrator were in the test room. The data logger worked from a separate room 

where they could see the participant’s screen and face shot, and listen to the audio 

of the session. To ensure that the environment was comfortable for users, noise 

levels were kept to a minimum with the ambient temperature within a normal range.  

All of the safety instruction and evacuation procedures were valid, in place, and 

visible to the participants. 

 
TEST ENVIRONMENT 
 

The EHRUT would be typically be used in a healthcare office or facility.  In this instance, the 

testing was conducted in a small office setting.  The participants used a Lenovo ThinkCentre 

All-in-one computer running Windows® 7 as the client machine. The display was a 20-inch 

monitor at resolution of 1920x1080 with 32 bit color depth.  The participants used both 

mouse and keyboard when interacting with the EHRUT.  

 

The application was set up according to standard Thrive documentation. The application 

itself was running on a Red Hat Linux server using representative test data.  The client 

machine was connected via a wired LAN connection. Technically, the system performance 

(i.e., response time) was representative to what actual users would experience in a field 

implementation. Additionally, participants were instructed not to change any of the default 

system settings (such as control of font size). 
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TEST FORMS AND TOOLS 
 

During the usability test, various documents and instruments were used, including: 

 
1. Non-Disclosure Agreement 
2. Informed Consent 
3. Incentive Receipt and Acknowledgment Form 
4. Moderator’s Guide 
5. Post-test Questionnaire 

 
 

Examples of these documents can be found in Appendices 1-5 respectively.  

 

The participant’s interaction with the EHRUT was captured and recorded digitally with screen 

capture software running on the test machine. A USB camera recorded each participant’s 

facial expressions synced with the screen capture, and verbal comments were recorded with 

a microphone. The test session was recorded for later review by the data logger. 

 
 
PARTICIPANT INSTRUCTIONS 
 

The administrator reads the following instructions aloud to the each participant (see 

the full moderator’s guide in Appendix 4): 

 

Thank you for participating in this study. Your input is very important. Our 
session today will last about 30 minutes. During that time you will use an 
instance of an electronic health record. I will ask you to complete a few 
tasks using this system and answer some questions. You should complete 
the tasks as quickly as possible making as few errors as possible. Please 
try to complete the tasks on your own following the instructions very 
closely. Please note that we are not testing you we are testing the system, 
therefore if you have difficulty all this means is that something needs to be 
improved in the system. I will be here in case you need specific help, but I 
am not able to instruct you or provide help in how to use the application. 

Overall, we are interested in how easy (or how difficult) this system is to 
use, what in it would be useful to you, and how we could improve it. I did 
not have any involvement in its creation, so please be honest with your 
opinions. All of the information that you provide will be kept confidential 
and your name will not be associated with your comments at any time. 
Should you feel it necessary, you are able to withdraw at any time during 
the testing. 

 
 

Following the procedural instructions, the administrator gave the following instructions: 
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For each task , I will read the description to you and say “Begin.” At that 
point, please perform the task and say “Done” once you believe you have 
successfully completed the task. I would like to request that you not talk 
aloud or verbalize while you are doing the tasks.  I will ask you your 
impressions about the task once you are done. 

 
 

Participants were then given 9 tasks to complete. Tasks are listed in the moderator’s guide in 

Appendix 4. 

 
 
 

USABILITY METRICS 
 
 

According to the NIST Guide to the Processes Approach for Improving the Usability 

of Electronic Health Records, EHRs should support a process that provides a high 

level of usability for all users. The goal is for users to interact with the system 

effectively, efficiently, and with an acceptable level of satisfaction. To this end, 

metrics for effectiveness, efficiency and user satisfaction were captured during the 

usability testing. 

 
The goals of the test were to assess: 

 
 

1.   Effectiveness of Thrive by measuring participant success rates and 
errors 

2.   Efficiency of Thrive by measuring the average task time and path 
deviations 
 

3.   Satisfaction with Thrive by measuring ease of use ratings 
 
 
DATA SCORING 

 
 

The following table (Table 1) details how tasks were scored, errors evaluated, and the time 

data analyzed. 

 
 

Measures Rationale and Scoring 
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Effectiveness: 
 

Task Success 
A task was counted as a “Success” if the participant was able to 
achieve the correct outcome, without assistance, within the time 
allotted on a per task basis. 

 

The total number of successes were calculated for each task and then 
divided by the total number of times that task was attempted. The 
results are provided as a percentage. 

 

Task times were recorded for successes. Observed task times divided 
by the optimal time for each task is a measure of optimal efficiency. 

 

Optimal task performance time, as benchmarked by expert 
performance under realistic conditions, is recorded when constructing 
tasks. Target task times used for task times in the Moderator’s Guide 
were defined by taking multiple measures of optimal performance and 
multiplying by a factor of 1.5.  This allows some time buffer because 
the participants are not trained to expert performance. Thus, if expert, 
optimal performance on a task was 10 seconds then allotted task time 
performance was 15 seconds.  

Effectiveness: 
 

Task Failures 
If the participant abandoned the task, did not reach the correct answer 
or performed it incorrectly, or reached the end of the allotted time 
before successful completion, the task was counted as a “Failure.” No 
task times were taken for errors. 

 
The total number of errors was calculated for each task and then 
divided by the total number of times that task was attempted. Not all 
deviations were counted as errors.  The results are provided as a 
percentage. 

 

On a qualitative level, an enumeration of all errors and error types 
were collected. 

Efficiency: 
 

Task Deviations 
The participant’s path (i.e. steps) through the application was recorded. 
Deviations occur if the participant, for example, went to a wrong screen, 
clicked on an incorrect menu item, followed an incorrect link, or 
interacted incorrectly with an on-screen control. This path was 
compared to the optimal path. The number of steps in the observed 
path is divided by the number of optimal steps to provide a ratio of path 
deviation.  A 1:1 ratio represents perfect completion of a task. 

Efficiency: 
 

Task Time 
Each task was timed from when the administrator said “Begin” until the 
participant said, “Done.” If he or she failed to say “Done,” the time was 
stopped when the participant stopped performing the task. Only task 
times for tasks that were successfully completed were included in the 
average task time analysis. Average time per task was calculated for 
each task. The total task time is divided by the optimal task time to provide 
a ratio of task completion time.  For this measure, task times faster than the 
optimal time were treated as equal to the optimal time.  This normalizes 
successes to a ratio of 1:1.  
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Satisfaction: 
 

Task Rating 
Participant’s subjective impression of the ease of use of the application 
was measured by administering both a simple post-task question as 
well as a post-session questionnaire. After each task, the participant 
was asked to rate “Overall, this task was:” on a scale of 1 (Very Difficult) 
to 5 (Very Easy). These data are averaged across participants. 

 
Common convention is that average ratings for systems judged easy 
to use should be 3.3 or above. 

 

To measure participants’ confidence in and likeability of the Thrive 
overall, the testing team administered the System Usability Scale 
(SUS) post-test questionnaire. Questions included, “I think I would 
like to use this system frequently,” “I thought the system was easy to 
use,” and “I would imagine that most people would learn to use this 
system very quickly.” See full System Usability Score questionnaire 
in Appendix 5. 

 
Table 1. Details of how observed data were scored. 

 
 

RESULTS 
 
 
 

DATA ANALYSIS AND REPORTING 
 
 

The results of the usability test were calculated according to the methods specified 

in the Usability Metrics section above. Participants who failed to follow session and 

task instructions had their data excluded from the analyses. 

 
 

The usability testing results for the EHRUT are detailed below (see Table 2. The 

results should be seen in light of the objectives and goals outlined in Section 3.2 

Study Design. The data should yield actionable results that, if corrected, yield 

material, positive impact on user performance. 

 
170.315(a)(6) Problem list 
Measure 
Task ↓ 

Numb
er of 
Users 

Success Path 
Deviation 

Optimal 
Task Time 
(seconds) 

Task Time Errors Task 
Ratings 
1=difficult 

# Mean  Deviations 
(Observed/O
ptimal) 

Multiplied 
by 1.5 

Mean in 
seconds 

Deviations 
(Observed/O
ptimal) 

Mean  Mean  

1 Identify 
the patient’s 
active 
problems 
(diagnosis) 

10 100% 1:1 45 6.2 1:1 0% 5 

2 Enter a 
new 
problem 
(diagnosis) 

10 100% 1.01:1 90 28.9 1:1 10% 4.9 



Page 14 of 25 
 

 

3. Modify an 
existing 
problem 
(diagnosis) 

10 100% 1:1 90 23.5 1:1 20% 4.9 

 
 

Table 2. Usability testing results. 
 

The results from the SUS (System Usability Scale) scored the subjective satisfaction with the 

system based on performance with these tasks to be: 77.5. Broadly interpreted, scores 

under 60 represent systems with poor usability; scores over 80 would be considered above 

average.  

 
DISCUSSION OF THE FINDINGS 
EFFECTIVENESS 

 
 

Based on the success, failure and path deviation data, the system was laid out logically with 

some confusion on data and search options. There were no major path deviations that 

caused a user not to complete a task. The users effectively used the system to complete 

each task. There were no deviations on task 1; comments were that it was very straight 

forward. Task 3 had one user deviation where the user went into the edit screen to change 

the description rather than utilizing the edit tool, adding one step to the process. 

 
 
EFFICIENCY 

 
 

Based on the task times, all of the users passed the task because they were able to 

complete it within the optimal time. Task 3 was the most time intensive task because the 

user had to modify information, but this did not prevent users from passing. The tasks were 

all completed successfully within the given amount of time. 

 
 
 
SATISFACTION 

 
 

Based on the task ratings, all the users found the tasks to be easy to very easy. The SUS 

score averaged out to be 77.5 with the lowest being 40 and the highest being 100. Based on 

the SUS score, all the users found the system to be above average on usability and overall 

satisfaction. 
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MAJOR FINDINGS 

 
 

The users found the tasks to be easy to use and very user friendly. The major areas where 

the users struggled to complete a task was when they realized there was more than one 

way to complete the task, so this caused some confusion for some of the users. Overall the 

users completed the tasks with few path deviations. 

 
 
AREAS FOR IMPROVEMENT 

 
 

Several users found the font size to be too small on the screens in the physician/provider 

application. On some of the edit screens, the users found some of the processes 

cumbersome. Re-labeling the data fields to be more appropriate would improve the user's 

experience and allow them to complete tasks more quickly. Another area that needs 

improvement is the location of the options on the screen. The users had to search the 

screen to find what option they needed to click on in order to select, edit and update the 

problem. Having one area to make edits would improve their speed and accuracy. 
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APPENDICES 
 
 

The following appendices include supplemental data for this usability test report.  Following 

is a list of the appendices provided: 

 1: Non-disclosure Agreement  

 2: Informed Consent Form 

 3: Incentive Receipt and Acknowledgement Form 

 4: Moderator’s Guide 

 5: System Usability Scale (SUS) Questionnaire 

  



Page 17 of 25 
 

 

Appendix 1: NON-DISCLOSURE AGREEMENT  

 

Usability Testing Non-Disclosure Agreement 
 
This agreement is entered into as of __________________________ (today's date) between  

____________________________ (“the Participant”) and the testing organization, CPSI (Computer 

Programs and Systems, Inc.) located at 6600 Wall Street, Mobile, Alabama.  The Participant acknowledges 

his or her voluntary participation in today’s usability study may bring the Participant into possession of 

Confidential Information. The term "Confidential Information" means all technical and commercial 

information of a proprietary or confidential nature which is disclosed by CPSI, or otherwise acquired by the 

Participant, in the course of today’s study. By way of illustration, but not limitation, Confidential Information 

includes trade secrets, processes, formulae, data, know-how, products, designs, drawings, computer aided 

design files and other computer files, computer software, ideas, improvements, inventions, training methods 

and materials, marketing techniques, plans, strategies, budgets, financial information, or forecasts.  Any 

information the Participant acquires relating to this product during this study is confidential and proprietary to 

CPSI and is being disclosed solely for the purposes of the Participant’s participation in today’s usability 

study. By signing this form the Participant acknowledges that s/he will receive monetary compensation for 

feedback and will not disclose this confidential information obtained today to anyone else or any other 

organizations.  

 
 
Participant’s printed name: ________________________________________________  
 
 
Signature: _____________________________________ Date: ____________________ 
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Appendix 2: INFORMED CONSENT FORM 

 

Usability Testing Informed Consent  
 
CPSI would like to thank you for participating in this study. The purpose of this study is to evaluate an 
electronic health records system. If you decide to participate, you will be asked to perform several tasks 
using the prototype and give your feedback. The study will last about 180 minutes (or 3 hours). At the 
conclusion of the test, you will be compensated for your time.  
 
Agreement  
I understand and agree that as a voluntary participant in the present study conducted by CPSI I am free to 
withdraw consent or discontinue participation at any time. I understand and agree to participate in the study 
conducted and videotaped by CPSI.   
 
I understand and consent to the use and release of the videotape by CPSI. I understand that the information 
and videotape is for research purposes only and that my name and image will not be used for any purpose 
other than research. I relinquish any rights to the videotape and understand the videotape may be copied 
and used by CPSI without further permission.  
 
I understand and agree that the purpose of this study is to make software applications more useful and 
usable in the future.  
 
I understand and agree that the data collected from this study may be shared with outside of CPSI and 
CPSI's client. I understand and agree that data confidentiality is assured, because only de-identified data – 
i.e., identification numbers not names – will be used in analysis and reporting of the results.  
 
I agree to immediately raise any concerns or areas of discomfort with the study administrator. I understand 
that I can leave at any time.  
 
Please check one of the following:  
 
 YES, I have read the above statement and agree to be a participant.  
 
 NO, I choose not to participate in this study.  
 
 

 

Signature: __________________________________________ Date: __________________________ 

Printed Name: ______________________________________________________________________ 

 

Witness: ___________________________________________ Date: ___________________________ 

Printed Name & Affiliation:_____________________________________________________________ 
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Appendix 3: INCENTIVE RECEIPT AND ACKNOWLEDGEMENT FORM 

 

Usability Acknowledgement of Receipt  
 
 
I hereby acknowledge that a check in the amount of   $75   will be sent to the name and address below for 
my participation in a research study run by CPSI (Computer Programs and Systems, Inc.). 
 
 
 
Printed Name: ___________________________________________________________  
 
Address: _______________________________________________________________  
 
               _______________________________________________________________ 
 
 
 
Signature: _________________________________ Date: _______________  
 
 
 
 
Usability Researcher: __________________________________  
 
Signature of Usability Researcher: ___________________________ 
  
Date: _______________  
 
 
 
 
Witness: ________________________________________  
 
Witness Signature: _______________________________________  
 
Date: _______________ 
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Appendix 4: MODERATOR’S GUIDE 

 

Usability Testing Moderator’s Guide 
 
Administrator ________________________  

Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  

Location ____________________________ 

 
 

Prior to testing  
• Confirm schedule with Participants. 
• Ensure that the lab environment is running properly. 
• Ensure lab and data recording equipment is running properly. 

 
Prior to each participant:  

• Reset application. 
• Start session recordings with Webex.  

 
Prior to each task:  

• Reset application to starting point for next task. 
 
After each participant:  

• End session recordings with Webex. 
 
After all testing  

• Back up all video and data files. 
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Orientation (5 minutes)  
Thank you for participating in this study. Our session today will last approximately 180 minutes (or 3 
hours). During that time you will take a look at an electronic health record system.  
 
I will ask you to complete a few tasks using this system and answer some questions. We are interested in 
how easy (or how difficult) this system is to use, what in it would be useful to you, and how we could 
improve it. You will be asked to complete these tasks on your own trying to do them as quickly as possible 
with the fewest possible errors or deviations. Do not do anything more than asked. If you get lost or have 
difficulty I cannot answer or help you with anything to do with the system itself. Please save your detailed 
comments until the end of a task or the end of the session as a whole when we can discuss freely.  
 
I did not have any involvement in its creation, so please be honest with your opinions.  
 
The product you will be using today is the Thrive EHR. Some of the data may not make sense as it is 
placeholder data.  
 
We are recording the audio and screenshots of our session today. All of the information that you provide will 
be kept confidential and your name will not be associated with your comments at any time.  
 
Do you have any questions or concerns?  
 
Preliminary Questions (5 minutes)  
What is your job title / appointment?  
 
What are some of your main responsibilities? 
 
 
How long have you been working in this role?  
□Less than 1 year  □1 to 3 years  □more than 3 years 
 
Have you ever used an electronic health record?    □ Yes     □ No 
 
If yes, do you currently use an electronic health record in your job?     □ Yes     □ No 
 
If yes, how often do you use the EHR? 
□Daily     □Weekly     □Monthly     □Less than once a month 
 
How many different EHRs have you used? 
□ One      □Two      □Three or more 
 
 
 
 
 
 
Data Logger ________________________  

Date _____________________________ Time _________  

Participant # ________  
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Thrive/Thrive Provider  
 
Task 1:   Problem List: Identify the patient’s active problems (diagnosis) 
_______________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
CW5- Charts – Number- Go- Problem List 
 
Read the following to the tester: 
The patient has presented to the facility and it has been awhile since their last visit. Identify the patient’s 
active diagnoses and the date of the diagnosis.  
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time:30____Seconds 
Optimal Path: Select Problem List – Select Active Problem of Coronary Artiosclerosis – Identify Diagnosis 
Date  
 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

Observed Errors and Verbalizations: 

Comments: 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 2:   Problem List: Enter a new problem (diagnosis) 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
CW5- Charts – Number- Go- Problem List 
 
Read the following to the tester: 
The provider has given the patient a new diagnosis for the recent visit. Enter a new diagnosis of Atrial 
Fibrillation with a diagnosis date of today’s date.   
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time: 60____Seconds 
Optimal Path: Select Problem List – Select New Problem- Search Atrial Fibrillation- Select Problem- Select 
Diagnosis Date-Choose Today-Update  
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

Comments: 

 

Observed Errors and Verbalizations: 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Thrive/Thrive Provider 

Task 3:   Problem List: Modify an existing problem (diagnosis) 

________________________________________________ 

Take the participant to the starting point for the task. 

Path from CW5 
CW5- Charts – Number- Go- Problem List 
 
Read the following to the tester: 
The provider has chosen to modify the recent diagnosis given to the patient. Modify the existing Atrial 
Fibrillation diagnosis to Chronic Atrial Fibrillation with the diagnosis date as today’s date. 
 
Success: 

    Completed 
    Completed with difficulty or help::Describe below 
    Not completed 
Comments: 
 
 
 

Task Time: ____________Seconds - Optimal Task Time: 60____Seconds 
Optimal Path: Select Problem List – Select Existing Problem- Select Edit Tool- Search New Problem 
Description- Select New Problem-Select Diagnosis Date-Update  
 
 

 Correct 
 Minor Deviations/Cycles::Describe below 
 Major Deviations::Describe below 

 

Comments: 

 

Observed Errors and Verbalizations: 

 

Comments: 

 

Rating: 

 Overall, this task was: 

 Show participant written scale: ”Very Difficult”(1) to “Very Easy”(5) 

 

Administrator/ Notetaker Comments: 
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Appendix 5: SYSTEM USABILITY SCALE (SUS) QUESTIONNAIRE 

System Usability Scale – Thrive          
               Strongly            Strongly  
               disagree              agree 
 
1. I think that I would like to  
   use this system frequently  
     
2. I found the system unnecessarily 
   complex 
     
3. I thought the system was easy 
   to use                        
 
4. I think that I would need the 
   support of a technical person to 
   be able to use this system  
 
5. I found the various functions in 
   this system were well integrated 
     
6. I thought there was too much 
   inconsistency in this system 
     
 
7. I would imagine that most people 
   would learn to use this system 
   very quickly    
 
8. I found the system very 
   cumbersome to use 
    
9. I felt very confident using the 
   system 
  
10. I needed to learn a lot of 
   things before I could get going 
   with this system    
 
 
 

Administrator Use Only 
 
 
Raw score: _________  SUS Score: _________ 

© Digital Equipment Corporation, 1986. 

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5  
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